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Introduction

This document describes the setup procedure of the sample program for RZ/N2L port of EtherNet/IP™
“OpENer”.
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1. Overview

This document describes the setup procedure of the sample program for RZ/N2L port of EtherNet/IP
“OpENer” and explains the procedure for connecting the CODESY'S software programmable logic controller
(PLC).

In this sample program, these open-source software are used.

- EtherNet/IP OpENer
- FreeRTOS
- wlIP

For demonstration, the application of this sample program has an Exclusive Connection and an Input Only
Connection. This document also explains how to connect to the CODESYS software prepared in package.

1.1 Abbreviations / Definitions
Table 1-1 Abbreviations/Definitions

Index Abbreviations Description
/Definitions
1 IP Internet Protocol
2 TCP Transmission Control Protocol
3 USB Universal Serial Bus
4 PC Personal Computer
5 SW Switch
6 EWARM Embedded Workbench® for ARM
7 IwlP lightweight IP
8 CIP Common Industrial Protocol
9 (ORT) Open-Source Software

1.2 Reference
Technical information about RZ/N2L is available via Renesas.

Table 1-2 Technical Inputs for RZ/N2L

Index Technical Inputs

1 r01uh0955ejxxxx-rzn2l.pdf (RZ/N2L User’s Manual: Hardware)

2 r01an6434ejxxxx-rzt2-rzn2-fsp-getting-started.pdf (Getting started with Flexible Software
Package)

3 r12ut0020edxxxx-rzn2l-som-kit-hw.pdf (RZ/N2L Industrial Network SOM Kit Use’s Manual)

1.3 Limitation / Known Issue
None
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2. Features

The "OpENer" is an open-source software for I/O communication adapters of EtherNet/IP. It supports
multiple 1/0O and explicit connections and includes objects and services for making EtherNet/IP-compliant
products as defined in the ODVA specification.

This package is the RZ/N2L port of OpENer and includes OpENer source codes. Regarding the open-source
license of OpENer, please see the following file.

common\oss\OpENer\license.txt

The Class Objects implemented in this sample software are as follows. For details, please see Chapter 7
Appendix C Table 7-3 ~ Table 7-9.

Table 2-1 CIP Object Classes supported on this sample software

Object Class # Object Class Name
0x01 Identity
0x02 Massage Router
0x04 Assembly
0x06 Connection Manager
OxF5 TCP/IP Interface
OxF6 Ethernet Link
0x48 QoS
RO1AN6798EJ0110 Rev.1.10 Page 4 of 51
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3. Project Setup

3.1 Requirements

This RZ/N2L IwlIP protocol stack project has been developed and tested on these environments using the
following boards and tools.

Table 3-1 RZ/N2L Requirements

Item Vender Description
Board Renesas Electronics RZ/N2L Industrial Network SOM Kit
IDE IAR Systems ® Embedded Workbench® for ARM Version 9.30.1

Please apply patch

(EWARM_Patch_for_ RZN2L)

which is available in http://www.renesas.com/rzn2l.
Regarding how to apply the patch, please read the
readme file in patch file.

Renesas Electronics ® ¢?studio 2023-04

® FSP Smart Configurator 2023-04

® RZ/N2L Flexible Software Package (FSP) v1.2.0
Please download from the link below.
https://github.com/renesas/rzn-fsp/releases/tag/v1.2.0

Emulator IAR Systems I-jet
SEGGER Hardware: J-Link
Software: J-Link Commander V7.82f *1
Evaluation CODESYS GmbH CODESYS v3.5.15.10 32-bit *2
Software
*1: J-Link Commander is used for erasing flash memory.

J-Link Commander is included in “J-Link Software and Documentation Pack” on the following site.
https://www.segger.com/downloads/jlink/

*2: Please use 32bit version, the 3.5.15.10 64-bit version and other versions may not work.
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3.2 Hardware Settings

This document describes the major hardware. Refer to RZ/N2L Industrial Network SOM Kit user's manual
and schematic for more board details.
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User LEDs

Figure 3-1 RZ/N2L Industrial Network SOM Kit

3.3 Note about Ethernet PHY driver using FSP

This SOM Kit has VSC8531 that is not compatible with FSP as PHY chip. Therefore, we have modified the
PHY driver for VSC8531. For details, see “Appendix D: FSP Configuration for VSC8531”.
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3.4 Setup the Board

Setting the board for running sample program is shown below.

1. Connect the I-jet to J2 or the USB cable to J5 for J-link OB on Carrier board.

L
gAtiidN o

999EE9EEs - GESCRNCS
i1 P T
L

ETHO

Figure 3-2 Setup the SOM Kit

2. Power is supplied by connecting USB Micro-B cable to the USB connector “J5) of the Carrier board.
3. Connect Ethernet Cable to the Ethernet Connector “ETHO0”.
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4. Setup the Host Device

4.1 Configuration the Host IP Address
Set an IP address that can communicate with the device in the Ethernet adapter settings on the PC side.

This sample software sets the IP address 192.168.1.170 and subnet mask 255.255.255.0 for the device by
default. Therefore, for example, set as follows on the PC side.

- IP address: 192.168.1.100
- Subnet mask: 255.255.255.0

4.2 Setup the CODESYS Software
This chapter describes the setup of the CODESYS software.

4.21 How to get CODESYS

CODESYS Development system is available from the following web sites. Please get version 3.5.15.10 32-
bit*.

*: Please note that the 3.5.15.10 64-bit version or other versions may not work.

- CODESYS Store
» To create your account and login is required to download the CODESYS tools.
< When you create the account as a business customer, you need:
- VAT Number if you are European VAT registered Customers.
- Certificate of Registration as Taxpayer (entrepreneur) if you are non-EU customers.
»  Clicks "All versions" tab to get the specified version.

- CODESYS Store North America
» To create your account and login is required to download the CODESYS tools.
< United States, Canada and Mexico only can be registered in the "Country" form of the
"Address Information".
»  Clicks "Versions" tab to get the specified version.

- LINX (Distributer in Japan)
» To create your account and login is required to download the CODESYS tools.
< Only Japanese companies can create the account.
» The latest version only is available.
< If you use the latest version, please try updating the CODESYS project included in this
package by referring the section Appendix A: How to update CODESYS project.

RO1AN6798EJ0110 Rev.1.10 Page 8 of 51
Aug 7, 2023 RENESAS



RZ/N2L Group RZ/N2L Industrial Network SOM Kit Application Note: EtherNet/IP OpENer Sample Program

4.2.2 Startup CODESYS Tools
After install the CODESYS, please launch the CODESYS tools shown below.

Table 4-1 CODESYS tools

CODESYS V3 IDE -

CODESYS Gateway V3 Software Gateway This may be already started by Windows Start
Up Process.

CODESYS Control Win V3 | Software PLC This may be already started by Windows Start
Up Process.

If the CODESYS is launched properly, the following window is shown.

File Edit View Project Build Online Debug Tools Window Help
BEFRIS >t R2BX|RGARE NI B0 8% ), aXN|(zr=="25 v K|~ |V
POUS. v 3 X Properties - 3 %
=  Fiter ~ | ¥ Sortby + #]sortorder -
Property Value
D POUs | 5 Devices
~ || 0eror(s) | ® owarning(s) | 0 message(s) || 2 ¥
Description Project Object Position
Description
@Propemas JY Notifications
Last build €3 0 % 0 Precompile . Project user: (nobody) Q .
Figure 4-1 CODESYS Initial Window
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If the CODESYS Gateway and Control Win SysTray is launched properly, the following icons are shown in
notification area of Windows Tool Bar. (The left icon is of the CODESYS Gateway, and the right one is of the

CODESYS Control Win SysTray)

Figure 4-2 CODESYS Icons

Please click each icon and click “Start Gateway” and “Start PLC”.

Start Gateway

Stop Gateway
Allow Edge Gateway configuration...

Exit Gateway Control

About...
Start Gateway

Stop Gateway
Allow Edge Gateway configuration...
Exit Gateway Control

About...

Figure 4-3 Start Gateway and PLC

If the Gateway and PLC is started properly, the icons pigment like the following image.

Figure 4-4 Icons with A and B successfully started
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4.2.3 Install EDS File into CODESYS
In the CODESYS, please open “tools” > “Device Repository” in tool bar.

File Edit View Project Build Online Debug | Tools | Window Help A\ d

B E &[0 = % BB X #8034 @  Packge Manager. P X, m N (v 0 |MT Y |
Library Repository...
Device Repository... | | properties -1 x
Visual Element Repository 7 Fiter = | ¥3 Sortby -

Visualization Style Repository... %lSo(t arder ~

License Repository...

Devices > 1 X

-

Property Value

= =P B

License Manager...

Scripting 3

Customize...

Options...

Import and Export Options...
@ Device Reader..

Messages - Total 0 error(s), 0 warning(s), 0 message(s) > 1 x
- ‘|° Oerror(s) | Owarning(s) |0 0 message(s) “ by &
Description Project Object Positicn
Description
|8 Propertes [W notAcations |
Last build: @ 0@ 0 Precompile o Project user: {nobody) e i
Figure 4-5 Device Repository in CODESYS
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Please click the “Install” to open dialog to select EDS file, and select the EDS file
‘renesas_opener_sample_app.eds” in “scanner” directory.

'__;:_': Device Repository

Location System Repository w Edit Locations...
(C:\ProgramData\CODESYS\Devices)

Installed device descriptions

|5h'ing for a fulltext search Wendor: | <Al vendors> w Install...

Name Vendor Version Description
+ m Fieldbuses

Ed QHMI devices

+- [ pLcs

£ ? SoftMotion drives

Close

Figure 4-6 Click "Install" in Device Repository Window
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If the Renesas OpENer Device is shown in the blue line as EtherNet/IP Remote Adapter, please click “close”
to close this window.

Edit Locations...

Location | System Repository »
(C:\ProgramData\CODESYS\Devices)

Installed device descriptions

String for a fulltext search Wendor: | <Al vendors> w Install...
Name Vendor Version Description 2 Uninstall
= == EtherNet/IP Export..

+ - BB Ethernet Adapter
+- = EtherMNet/IP Local Adapter
+-- = EtherNet/IP Module

= == EtherMet/IF Remote Adapter
m Generic EtherNet/IP device 35 - Smart Software Solutions GmbH 3.5.15.0 EtherNet/IF Target fi
m |Renesas OpENMer Device Renesas Electronics Major Revision=1672, Minor Revision = 16#3 EtherNet/IP Targetin

+ - == EtherMet/IP Scanner

+ ﬁ Home&Building Automation

S G T il P
< >

Details...

= € D:¥git¥dls¥OpENer_development¥OpENer_applications¥scanner¥renesas_opener_sample_app.eds
¥ Device "Renesas OpENer Device” installed to device repository.

Close

Figure 4-7 EtherNet/IP Remote Adapter

Preparation for using CODESYS is now complete. Continue with the program operation in Chapter 5 and
then operate CODESYS again in Chapter 6.
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5. Running the Sample Application
Before following this chapter, please look at Section 3.2 and 3.4 for board setup.
The setup differs depending on the IDE.

- When using e?studio, refer to section 5.1.

- When using EWARM, refer to section 5.2.

5.1 Setup sample project for e? studio
Replace the project name in the figure with the project name of this sample project.

5.1.1 Startup e? studio
1. Open the e? studio and select a directory as workspace.

2. Click “Open Projects from File System...” in File tab.

8 workspace - € studio

File Edit Source Refactor Navigate Search Project Re
New Alt+Shift+N >
Qpen File...

IL.' Open Projects from File System... I

Recent Files >

Close Editor Ctrl+W
Close All Editors Ctrl+Shift+W
Save Ctrl+5S
Save As...

Save All Ctrl+Shift+S

Revert

Move...

Rename... F2
&1 Refresh F5

Convert Line Delimiters To >

Print... Ctrl+P

E

Import...
=i Export...

Properties Alt+Enter
Switch Workspace >

Restart
Exit

Figure 5-1 e”studio File tab
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3. Import the project folder.

Import “\project\rzn2l_som\opener_single\e2studio”.

& Import Projects from File System or Archive O X
Import Projects from File System or Archive ¥

This wizard analyzes the content of your folder or archive file to find projects and import them in the IDE. / /

Import source: Extracted zip folder path project\rzn2|_rsk\opener_single\e2studio v II Directory... Archive...

N\
It;.-pe filter text \ I Select All
\
Folder Import as Deselect All
[ e2studio Eclipse project

1 of 1 selected

[JHide already open projects

[J Close newly imported projects upon completion

Use installed project configurators to:
Search for nested projects

Detect and configure project natures
Working sets
(] Add project to working sets New...

Select...

Show other specialized import wizards

1(?)\ < Back Next > Cancel

Figure 5-2 Import project on e®studio
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5.1.2 Board IP Address Setting
The IP address is set in src/renesas/application/opener_port_instance.c.

The following addresses are used in the example:

IP address :192.168.1.170
Subnet mask : 255.255.255.0
Default gateway :192.168.1.1

Host Name : OPENER_NETIFO

Q workspace - RZN2L_RSK_OpEMer_single/src/renesas/application/opener_port_instance.c - €° studio
File Edit Source Refactor Mavigate Search Project RenesasViews Run  Window Help
- 45 Debug || [ RZNzL_RSK_OpENer_single Debug, il | &~/ -~ % e B Q- - -
GBi-&- -G~ = IR -t (o v -|=|_|p
Fia Project Explorer %G % § = 8 | [g openerport instance.c 3 | [g startup.c = 8
v b REN2L RSK_OpENer single [In e2studio); 53 @ * Example of CIP Mon-volatile attribute configuration. 2
Iﬂ] Includes 56 #define SAMPLE_TCPIP_CONFIG_METHOD (LWIP_PORT_DHCP_DISABLE) ///< Relate
v 8 src 57 #define SAMPLE_TCPIP_ENCAP_TIMEOUT VALUE (128) ///< TCP/IP interface object
i oss 58 #define SAMPLE_QOS_DSCP_VALUE_URGENT (55U) ¢ QoS Object attribute: DS
o 59 #define SAMPLE_QUS_DSCP_VALUE_SCHEDULED (47V) < QoS Object attribute: DS
{37 renesas 50 #define SAMPLE_QO5_DSCP_VALUE_HIGH (430) /< QoS Object attribute: DS
v gy application 51 #define SAMPLE_QOS_DSCP_VALUE_LOW (310) ‘< QoS Object attribute: DS| =
@ board_io_define.h 52 #define SAMPLE_QOS_DSCP_VALUE_EXPLICIT (27u) /< QoS Object attribute: DS
& opener_port_instance.c 63
[, opener_part_main.c 65 o E):anple of TCP/IP configuration related to CIP TCP/IP interface object.[] 1
57 #define SAMPLE_STATIC_IP_ADDRESS PP_HTONL (LWIP_MAKEU32(192,168, 1,17@)) /f/<
gy module #define SAMPLE STATIC SUBNET MASK PP_HTONL(LWIP_MAKEU32 (255,255,255, @)) /
[y oss_deps #define SAMPLE_STATIC_GATEWAY ADDRESS  PP_HTONL({LWIP_MAKEU32(192,168, 1, 1)) /f/<
[€] hal_entry.c #define SAMPLE_HOSTNAME "OPENER_NETIF@" /<
[€] main_thread_entry.c
- : ® * Private constants[]
= script
%- 2 " ' 76 @ * Typedef definitions[]
% configuration.xml . 79 * Private function prototypes[]
R2A07G0B4MOBGEG. pincfy a2 ® * Private global variables[]
rzn_cfg.xt 85 @ * global Variables[]
E| RZM2L_RSK_OpENer_single Debug_Flat,jlink 88 ® * Serial I0 module instancef]
] RZN2L_RSK_OpENer_single Debug_Flat.laun 98 stat:}c ser:!.al_ll.o_lnstance_ctrl_t gTser‘:!.al_m@_ctr‘lj
a1 static serial io_cfg_t const g_serial_jo@ cfg =
92 {
e 93 .p_uart_instance = &g _uarta,
94 1
95 serial io instance t const g serial io@ = N
£ >
Figure 5-3 Static IP address
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5.1.3 How to generate source code and how to build
1. Click the Configuration.xml.

B Project Explorer = <}='=l> r § = B
W {3:“5- RZM2L_RSK_OpEMer_single (in edstudio)

hl Includes

2 sre

. crrint

1%t configuration.cml

= ROADTGOEAMOBGEG.pincfg

= rzn_cfg.txt

= REZMZL_RSK_OpEMer_single Debug_Flat.jlink

|%] REM2L_RSE_OpEMer_single Debug_Flat.launch

Figure 5-4 Configuration

2. Click ‘Generate Project Content’ button then generate rzn, rzn_gen, rzn_cfg folder.

Q workspace - RZN2L_RSK_OpENer_single/configurationxml - &° studio
File Edit Source Refactor MNavigate Search Project RenesasViews Run  Window Help
5. Debug || B9 RZM2L_RSK_OpENer_single Debug, + = | ® -/ -3 % W4 Qi -
EBraiv -G i@~ I - -t o =
I Project Explorer 5% Y § = B [gwipportinstancec 455 [RZN2L_RSK_OpENer single] FSP Configuration 3¢ = B8
£ RZNZL_RSK_OpENer_single (in eZstudio) .
Vi ) "R UPERELSINGE U ecstudlo Stacks Configuration 0
[ Includes Generate Project Content
g src
(= script & | New Thread HAL/Common Stacks & | New Stack >
420 configurationaoml Threads =
.55 ROADTGDBAMOBGEG. pincfy — 42 g_ioport /0 Port
= rzn_cfg.tut Vi 'I-LALJ‘.Common ) Driver on r_ioport
|Z] RZN2L_RSK_OpENer_single Debug_Flatjlink 4 g_ioport 170 Port Driver on 1
|x] RZM2L_RSK_OpEMer_single Debug_Flat.launch v Main Thread @
e g_etherl Ethernet Driver on
e g_uartd UART Driver on r_sci
47 Heap 4
< >
. & | New Object »
Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components
Figure 5-5 Generate Project Content
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B Project Explorer 3 = <‘1'='=l> Y § = B
W b_—',:,- RZNZ2L_RSK_OpENer_single (in e2studic) [Debug
it Includes
[ rzn

2 rzn_gen
@ srC

= rzn_cfg
[= scnpt
ﬂia:f configuraticn.xml
ROADTGOEAMOBGEG. pincfg
rzn_cfg.tet

RZM2ZL_RSK_OpEMer_single Debug_Flat,jlink
RZM2L_RSK_OpEMer_single Debug_Flat.launch

[==,) [0 [T e

Figure 5-6 Generate project folder

3. Click the Build button in tool bar to build the project and confirm that there is no error message in build
message log.

a workspace - RZM2L_RSK_OpEMer_single/configuration - e" studio
File Edit Source Refactor Mavigate Search Project Renesas Views Run Window Help
EMENLD H; Debug vHEl RZN2L_RSK_OpENer_single Debug ‘ il R ER PR 2

Figure 5-7 Build button

&L Problems | B Console  |@ Smart Browser [} Smart Manual X| &€ 4 <§>| LE B
CDT Build Conscle [RZNZL_RSK_OpEMer_single]

i ' n -7 ~
Building target: RZN2L_RSK_OpENer_single.elf
arm-none-gabi-objcopy -0 ihex "RIN2ZL_RSK_OpENer_single.elf™ "RINZL_RSK_OpENer_single.hex”

arm-none-eabi-size --format=berkeley "RZN2L_RSK_OpENer_single.elf”
text data bss dec hex filename

137678 392 368212 498282 79aba RZIN2ZL_RSK_OpENer_single.elf

"EE B8 -85-= 0O

17:57:54 Build Finished. @ errors, 378 warnings. (tock 24s.193ms)

Figure 5-8 Build message
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RZ/N2L Group RZ/N2L Industrial Network SOM Kit Application Note: EtherNet/IP OpENer Sample Program

5.1.4 Download application and run debugger
1. First, erase the flash memory by following the steps below. This step can be skipped after erasing the
flash memory.

Open the J-Link Commander.

KA J-Link Commander v7.82f - O X
{Z:-E‘._J GER G i 200

7' for help

Figure 5-9 Open J-Link Commander
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First, type “connect” to establish a target connection and press enter.
Next, specify the connection conditions as follows.

- Device> (Default = press enter)

- TIF>S

- Speed> (Default = press enter)

After that, confirm the message “Cortex-R52 identified.” Is displayed.

" to establish a target conrection, '?" for help

n

|l

et interfs

ault>: 4000 kHz

I

Figure 5-10 Connection conditions (1/2)

Ed J-Link Commander v7.82 - | X

Figure 5-11 Connection conditions (2/2)
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Use the commands below to enable flash erase and erase the flash memory.
- >exec EnableEraseAllFlashBanks
- >Erase 0x60000000, 0x60100000

After that, confirm the message “Erasing done.” Is displayed.

Enter “q” to exit J-Link Commander.

KA J-Link Commander v7.82 - O X

an old firmware module

Figure 5-12 Erase flash memory (1/2)

B J-Link Commander v7.82¢ - | X

Compare: 0.0

00] deleted.

Figure 5-13 Erase flash memory (2/2)
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2. Return to e2 studio. Click the Debug button in tool bar to download the built application program and
launch the debugger.

File Edit Source Refactor MNavigate Search Project RenesasViews Run  Window Help

4 Debug [E%) RZN2L_RSK_OpENer_single Debug - | B~ |~ % e 2le1a-

Figure 5-14 Debug button

3. Click to “Switch” button.

Q Confirm Perspective Switch et

|@ This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective supports application debugging by providing views for displaying the
debug stack, variables and breakpoints.

Switch to this perspective?

[] Remember my decision

I Switch No

Figure 5-15 Confirm Perspective Switch

RO1AN6798EJ0110 Rev.1.10 Page 22 of 51
Aug 7, 2023 RENESAS



RZ/N2L Group RZ/N2L Industrial Network SOM Kit Application Note: EtherNet/IP OpENer Sample Program

4. The program will break at “system_init” for startup.

[€] Iwip_port_instance.c 48% [RZNZL_RSK_OpENer_single] FSP Configuration = 0
290 1 A
291
293 @ * After boot processing, LSI starts executing here.[]

205 = BSP_TARGET_ARM BSP_ATTRIBUTE_STACKLESS void system_init (void)
208 L
297 | __asm volatile ( I
298 set_hactlr: "
299 " MOVW r@, ¥[bsp hactlr_bit 1] W™ /* Set HACTLR bits(L) */
Jaa " MOWT  ri@, #8 n"
3@1 " MCR pl5, #4, r@, cl, c@, #1 \n" /* Write r@ to HACTLR */
382 t:[bsp_hactlr bit 1] "i" (BSP_HACTLR_BIT_L) : “"memory”);
383
304 __asm volatile (
385 "set_her: n"
386 " MRC pls, #4, rl, cl, cl, #@ \n" /* Read Hyp Configuration Register */
387 " ORR  rl, rl, ¥[bsp hcr _hcd_disable] “n™ /* HVC instruction disable */
388 " MCR pls, #4, rl, cl, cl, #@8 Wn" /* Write Hyp Configuration Register */
3@9 t:[bsp_hcr_hcd_disable] "i" (BSP_HCR_HCD DISABLE)} : "memory™);
31e
311 __asm volatile (
312 "set_whar: \n"
313 " LDR  r@, =vector_table n"
314 " MCR  pls, #8, r@, cl2, c@, #@ \n" /* Write r@ to VBAR */
315 1 "memory);
316
317 __asm volatile (
2187 "11PD arcass enahla: " v
£ >
Figure 5-16 Break point 1
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5. Before running the loaded program, please change the CPSR register of CR52 general register on
Registers tabs.

- Change the “T” register bit (bit 5 in CPSR register), which is Thumb execution state bit, from “1” to “0” to
switch the instruction mode from “Thumb” to “Arm”.

»  When the register value is “0x000001fa”, set it to “0Ox000001da”.

If the value of “T” bit in CPSR register is not changed, please note that the program does not work properly
when running.

& Console EEISEEEA (i) Debug Shell 2! Problems & Debugger Console 0 Memory

Name Value

v & General Registers
1t 10 0x1
11 0x80281a10
i r2 0xa>00
3 0x80281300
W T4 Oxbb92caf
5 Ox1e58a574
1 16 0x0
7 0x0
18 0x0
19 0x0
10 0x0
1 0x0
W12 Oxe51f004
W sp 0x101fe8
W lr 0x10006d
it pc 0x102000

| wepsr 02000012 | Ox200001da

Figure 5-17 CPSR register of CR52 generic register on Registers tab

6. Click the Resume button. The program will break at the first of main function.

Q workspace - RZN2L_RSK_OpENer_single/rzn/fsp/src/bsp/cmsis/Device/RENESAS/ Source/startup.c - € studio

File Edit Source Refactor Mavigate Search Project RenesasViews Run  Window Help

5 Debug 57 RZN2L_RSK_OpENer_single Debug - EXXST R Y R

Figure 5-18 Resume button
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RZ/N2L Group RZ/N2L Industrial Network SOM Kit Application Note: EtherNet/IP OpENer Sample Program

lwip_port_instance.c ] [RZM2L_RSK_OpENer_single] FSP Configuration startup.c main.c X = 0
PP - (8 g q P

77 } A

}
= int main(void)
L
g_fsp_common_thread_count = @; I
B Top_common_1nitiallized = Talse;
/* Create semaphore to make sure common init is done before threads start running. */
g_fsp_common_initialized_semaphore =
- #if configSUPPORT_STATIC_ALLOCATION
xSemaphoreCreateCountingStatic(

= #else
xSemaphoreCreateCounting (

#endif

[
G B LR

2586,
1

88 - #if configSUPPORT_STATIC_ALLOCATION
89 , &g _fsp common_initialized semaphore_memory
a8 #endif
91 }H
a2
a3 s if (NULL == g_fsp_common_initialized semaphore)
a4 {
as rtos_startup_err_callback (g_fsp_common_initialized_semaphore, @);
96 }
a7 v
< >
Figure 5-19 Break point 2
7. Click the Resume button again to execute the program.
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5.2 Setup sample project for EWARM
Replace the project name in the figure with the project name of this sample project.

5.2.1 Startup EWARM
1. Open the EWARM.

2. Click “Open Workspace...” in the File tab.

° IAR Embedded Workbench IDE
m Edit View Project Tools Window Hzs
T Mew File Ctrl+N
1™ Mew Warkspace

Open File... Ctri+ O
Open Workspace..

Open Header/'Source File Ctri+ Shift+H
Close Ctri+F4

Save Workspace

Save Workspace As...

aRB & onie

Close Workspace

Figure 5-20 EWARM file tab

3. Select the Workspace File(.eww) and click the Open button.

“\project\rzn2l_som\opener_single\ewarm\RZN2L_SOM_EIP_OpENer.eww”

€ Open Workspace d
<« v 4 <« project » rzn2l_rsk » opener_single » ewarm v D /2 Search ewarm
Organize - Mew folder = W @
~ Mame Date modified Type Size
7 Quick ace
settings 9/ 1:39 AM File folder
[ Desk # J _ )
Debug 9/ 2:37 PM File folder
¥ Dow # rZn 1:39 AM File folder
pD_c# rzn_cfg G 1:39 AM File folder
& OneDrive rZr_gen G 1:46 AM File folder
script 9/ 1:39 AM File folder
& My PC:R settings 201 PM File folder
- 3D Obje srC 9 :08 PM File folder
[ Desktog r@ RZM2ZL_RSK_OpEMer_single.eww I 9/ 1:39 AM |AR IDE Workspace 1EKB
5D
[£ Documu .
File narne: | RZMNZL_RSK_OpEMer_single.eww “ | Workspace Files (*.eww) ~
Figure 5-21 Open project file
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5.2.2 Board IP Address Setting
The IP address is set in \common\renesas\application\opener_port_instance.c.

The following addresses are used in the example:

IP address :192.168.1.170
Subnet mask : 255.255.255.0
Default gateway :192.168.1.1

Host Name : OPENER_NETIFO

— D buildinfo.ipct
B Output

AZN2L_RSK_OpEMer_single

* Private censtants

@ RZM2L_RSK_OpEMer single - IAR Embedded Workbench IDE - Arm 9.30.1 — ] *
File Edit Wiew Project I-jet Tools Window Help
N O @ s KD C FLA> HECBORNE RS =0 Nid]

Workspace * I X | opener_port_instance.c X =7
Debug| w fiy
- #define SAMPLE_TCPIP_CONFIG_METHOD (LWIP_PORT_DHCP_DISABLE) ///< Related to TCP/IP inte
Files o #define SAMPLE_TCPIP_ENCAP_TIMEOUT_VALUE (128) ///< TCP/IP interface object attribute : enca

B @ RZN2L_RSK_OpENer_single ... + #define SAMPLE_QOS_DSCP_VALUE_URGENT (55U) J///< QoS Object attribute: DSCP urgent (#4)
=1 W comman #define SAMPLE_QOS_DSCP_VALUE_SCHEDULED (47U) ///< QoS Object attribute: DSCP scheduled (#5
B 0ss #define SAMPLE_QOS_DSCP_VALUE_HIGH (43U) ///< QoS Object attribute: DSCP high (#8)
La i renesas #define SAMPLE_QOS_DSCP_VALUE_LOW (31U) ///< QoS Object attribute: DSCP Low (#7)
= ; #define SAMPLE_QOS_DSCP_VALUE_EXPLICIT (27U) S//< QoS Object attribute: DSCP explicit (#8)
M spplication - - -
| — B board_io_define.h i
| S - * Example of TCP/IP configuration related to CIP TCP/IP interfoce object.
| openar_pot_main.c */
i module #define SAMPLE_STATIC_IP_ADDRESS PP_HTONL(LWIP_MAKEU32(192,168, 1,178)) /R/< TCP/IP interface
M 0s5_d=ps #define SAMPLE_STATIC_SUBNET_MASK PP_HTONL (LWIP_MAKEU32(255,255,255, 8)) /B/< TCP/IP interface
& Flex Softwars #define SAMPLE_STATIC_GATEWAY_ADDRESS ~ PP_HTONL(LWIP MAKEU32(192,168, 1, 1)) /Q/< TCP/IP interface
#define SAMPLE_HOSTNAME OPENER_NETIF@ /A< TCP/IP interface

Figure 5-22 Static IP address
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5.2.3 How to generate source code and how to build

1. Click the “Tool” -> “FSP Smart Configurator” on tool bar. If you have not set up FSP Smart Configurator

yet on EWARM, refer to r01an6434ejxxxx-rzt2-rzn2-fsp-getting-started.pdf in which section 5.4 describes
how to set up it.

@ RZM2L_RSK_OpENer_single - IAR Embedded Workbench IDE - Arm 9.30.1 - O X
File Edit Wiew Project I-jet | Tools | Window Help
DO R @ = R [ options. Q>%r=2< B >0 RO -=0 > idh_
Workspace Filename Extensions... 7
Configure Viewers... F”
- Confloure Custom A £ Variabi | CONFIG_METHOD (LWIP_PORT_DHCP_DISABLE) ///< Related to TCP/IP inte
Files anrigure Custam Argument Variables... | ENCAP_TIMEQUT VALUE (128) ///< TCP/IP interface object attribute : enca
B @RZN2L_RSK_OpENer_| /& Configure Tools.., 5CP_WALUE_URGENT (55U) ///< Qos Object attribute: D5CP urgent (#4)
& comman 5CP_VALUE_SCHEDULED (47U)  ///< Qos Object attribute: DSCP scheduled (#5
B Flax Software IAR Project Converter 5CP_WALUE_HIGH (43U) J///< QoS Object attribute: DSCP high (#6)
l_ Dl buildinfo.ipct P_VALUE_LOW (31U) /< QoS Object attribute: DSCP Low (#7)
& Output 1P I RZ Smart Configurator P_VALUE_EXPLICIT (27U) /S« QoS Object attribute: DSCP explicit (#8)
S
T * Example of TCP/IP configuration related teo CIP TCPR/IP interface object.
=/
#define SAMPLE_STATIC_IP_ADDRESS PP_HTONL (LWIP_MAKEU32(192,168, 1,178)) ///< TCP/IP interface
#define SAMPLE_STATIC_SUBNET_MASK PP_HTONL (LWIP_MAKEU32(255,255,255, ®)) ///< TCP/IP interface
#define SAMPLE_STATIC_GATEWAY ADDRESS  PP_HTONL(LWIP_MAKEU32(192,168, 1, 1)) ///< TCP/IP interface
#define SAMPLE_HOSTNAME "OPENER_NETIFa@" J//< TCP/IP interface
/
* Private constants
/
* Typedef definitions
Y
* Private functien prototypes
e T e r— N
Figure 5-23 Tools tab
2. Click ‘Generate Project Content’ button then will be generate rzn, rzn_gen, rzn_cfg folder.
IS FSP Smart Configurator — O X
File Help Run
8% [FSP_Project] FSP Configuration X = B %5 FSP Visualization §&] Package S
Summar (V] 3 relE 5
y Generate Project Content ﬁ % £
Project Summary ) -
RENESAS Y Yo Y '???*
Board: RSK+RZN2L (RAM execution without flash memory) I e m : N @gg;zg l
Device: RIAD7G084MOBGBG T T Lo IsC LT -
FSP Version: 1.0.0 OBRO- &
Project Type: Flat st e R
2 BSOS R RN -8
Location: Irzn2|_rsklopener_single/ewarm ==| BEeCie -
Selected software components v e @ - T 0T 300 50 0 - e
= T o DR 3 Yol
Support | {@EEE
Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks| Compenents | » Legend
Figure 5-24 FSP SC Smart Configurator
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3. Click the Make button on tool bar to build. Once the build is completed, the build message is displayed in
the Build Console window that displays compilation target files and the number of error/warnings.

e RZMNZL_RSK_OpEMer_single - IAR Embedded Werkbench IDE - Arm 9.30.1 — O

File Edit View Project I-jet Tools Window Help

O @ L L LD e . <Q>%2<0>0 Ne}=0. 05l

Figure 5-25 Make button 1

Build * o =X

Messages File Line

Iwip_por_instance.c
RZMNEZL_RSK_OpEMer_single.out
Postbuild command

50% Generating Smart Bundle100% Generating Srar Bundle

Tatal number of errars: 0
Total number of warmnings: 238

Build succeeded

Build Debuglog References Sowurce Browse Log —Call Graph

Figure 5-26 Make button 2 and Build console
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5.2.4 Download application and run debugger

1. Click the Debug button in tool bar to download the built application program and launch the debugger.
The program will break at the first code in main function.

File Edit Wiew

MO Rd =

Project  |-jet

Tools

e RZMNZL_RSK_OpEMer_single - IAR Embedded Werkbench IDE - Arm 9.30.1

Window Help

< Q > 5= < Q> [A[)

Figure 5-27 Debug button

e RZMzL_RSK_COpEMNer_single - IAR Embedded Workbench IDE - Arm 9.30.1

RZNZL_RS5K_OpEMNer_single

File Edit WView Project Debug Disassembly I-jet Tools Window Help
L o WD - £ Q> K= >0 B@=GCcO®in 3
Workspace » 0 X | mainc » opener_port_instance.c -
Debug v ‘Fi.'l
: 5 {
Files o err = xSemaphoreGive(g fsp_common_initialized_semaphore);
E @RZN2L_RSK_OpE... ~ if (pdPASS != err)
B comman =]
i Flex Software /% Check err, problem occurred. */
l_ Dbuildinfo.ipc‘f , rtos_startup_err_callback(g_fsp_common_initialized_semaphore, @)
4 Output g_fsp_common_thread_count--;
r ¥
r h
- ¥
int main(void)|
=) 1
g_fsp_common_thread_count = @3
g_fsp_common_initialized = false;
/* Create semaphore to make sure common init is done before threads start ro
g_fTsp_common_initialized_ semaphore =
= #if configSUPPORT_STATIC_ALLOCATION
xSemaphoreCreateCountingStatic(
#else
= xSemaphoreCreateCounting(
- #endif
256,
1
= #if configSUPPORT_STATIC_ALLOCATION
» &g_fsp_commeon_initialized_semaphore_memory
- #endif

2. Click the Go button.

Figure 5-28 Break point

DR =

File Edit Wiew Project Debug Disassembly I-jet Tools

o WD C

e RZNZL_RSK_OpEMer_single - IAR Embedded Workbench IDE - Arm 9.30.1

Window Help

Q> KE<B>A0  B@-=GCcO_in3Iro] 8- _iEmsi

Figure 5-29 Go button
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6. Demonstration of the application with the CODESYS
6.1 Application Behavior

For demonstration, the application of OpENer RZ/N2L port has an Exclusive Connection and an Input Only
Connection. The connections between the RZ/N2L application and the CODESY'S project application is

shown below.

Ethernet Rz

0O s @

CODESYS Scanner EtherNet/IP  OpENer Adapter

n

Board_LED_Input (_ No.100 LED Input
Board_LED_Output ﬁ No.150 LED Output

Exclusive Owner Connection

Application.PLC_PRG (

Application.PLC_PRG Board_SW_Input No.101  J6 Input

Input Only Connection

) bound to LED1~4 on SOM Kit

«— bound to J6-1~J6-4 on SOM Kit
(Heartbeat) ——> No0.238 Input Only Heartbeat

The PLC program of CODESY'S project is shown below. The PLC program is described by ST(Structured

Text) language.

CycleCounter := CycleCounter+Board SW Input;
IF CycleCounter > CyclePerTick THEN
CycleCounter := CycleCounter-CyclePerTick;
IF 0 < Board LED Input AND Board LED Input < 8 THEN
Board LED Output := Board LED Input * 2;
ELSE
Board LED Output :
END IF
END IF

1;

» The Exclusive Owner Connection is bound to LED of RZ/N2L Industrial Network SOM Kit.

- The PLC program make the LEDs light by shifting every CyclePerTick .

»  The Input Only Connection is bound to J6-1 ~ J6-4 of RZ/N2L Industrial Network SOM Kit.

for controlling the frequency of LED light shifting.

The PLC program read the SW values and change the incrementation value of CycleCounter

RO1AN6798EJ0110 Rev.1.10
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CODESYS application can be shown page.

9 opener sample app.project - CODESYS

File Edit View Project Build Online Debug Tools Window Help Y
=] =HEd & & x| d4 A, l’ﬁ A: LI I B | CHE A _‘T fEad] Application [Device: PLC Logic] ~ 'vﬁ L2 Z =
Devices - 1 X [f]_Device [ Ethernet [l Renesas_OpENer_Device |21 PLC_PRE x
= opener_sample_app e+ & | X PROGRAM PLC_PRG

= D CODESYS Control Win V3, o~
m @?‘Ee ( ontrol Win V3) Scope Mame Address Data type Initializaticn Comment Attributes
= PLC Logic
" -~ % VAR Board_SW_lInput BYTE Switch Input 2
=1} Application 4
G P VAR Board_LED_Input BYTE LED Input
[l Library Manager N =
e 3 % VAR  Board_LED_Output BYTE OLD Output E)
=T Tasl:CDnﬁguraﬁDn 4 % VAR  CycleCounter INT 0 1 Cycle = 20ms E;
” s VAR CyclePerTick NT 50 1Tick =15 g
= @ EMIPScannerIOTask (IEC-Tasks) # yalererhic - @
@ EtherNet_IP_Scanner.I0OCyde Va rFia b |ES
= @ EMIPScannerServiceTask (IEC-Tasks) < 5
@ EtherMet_IP_Scanner.ServiceCyde )- =
= @ MainTask (IEC-Tasks) 1 CycleCounter := CycleCounter+Board SW_Input;
@ PLC PRG 8 2 IF CycleCounter > CyclePerTick THEN
4 m h t - CycleCounter := CycleCounter-CyclePerTick;
Ethernet (Ethernet) 2] 0 < Board LED Input AND Board LED Input < & THEN
= m EtherMet_IP_Scanner (EtherMNet/TP Scanner) I Board LED Output := Board LED Input * 2:
ﬂi Renesas_OpENer_Device (Renesas OpEMer Des =] ELSE
l 7 Board LED Output := 1;
E END_IF
s END_IF Programs
< >
) POUs |52 Devices w0 |Ey
Messages - Total 0 error(s), 0 warning(s), 12 message(s) - 3 X
Download » | Oeror(s) | ® 0warning(s) |8 1 message(s) | by K

Description Project Object Paosition

# A core dump created on the 2021/06/24 18:16: 22 for the application 'Application’ is available on the device,

Last build: €3 0 0 Precompile » ‘B Project user: {nobody) ms Ln8 Colll chs (5]

Figure 6-1 CODESYS Project included in this sample program

6.2 IP and MAC Address Configuration

6.2.1 IP Configuration

This program sets own IP and related parameters to the following values defined statically by
“g_lwip_port0_netif _cfg” variable in “common\renesas\opener_port_instance.c”.

If changing the IP configuration, please change the following parameters.

Table 6-1 IP Configuration

Item Value Variable

IP Address 192.168.1.170 g_Iwip_port0_netif_cfg.ip_address

Net Mask 255.255.255.0 g_lwip_port0_netif_cfg.subnet_mask
Gateway 192.168.1.1 g_lwip_port0_netif_cfg.gateway_address
Address

Host Name OPENER_NETIFO g_Iwip_port0_netif _cfg.p_host_name
DHCP LWIP_PORT_DHCP_DISABLE | g lwip_port0_netif cfg.dhcp

If using DHCP, please set “g_lwip_port0_netif cfg.dhcp” to “LWIP_PORT_DHCP_ENABLE”. After the
program starts, DHCP process is executed to get an IP address dynamically. If the program gets an IP
address, EtherNet/IP communication starts.
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6.2.2 MAC Address Configuration
The MAC address is set to the following values defined statically by FSP Configurator.

Table 6-2 MAC Address Configuration

MAC Address 00:11:22:33:44:55

If changing the MAC address, please change the value on FSP configuration.

Regarding FSP configuration, please see the "RZ/T2M, RZ/N2L Getting Started with Flexible Software
Package" (r01an6434ejxxxx-rzt2-rzn2-fsp-getting-started.pdf) document.

6.3 Startup Software PLC

6.3.1 Open CODESYS project

Please select “File” > “Open project...” in CODESYS tool bar and open “opener_sample_app.project” in
“scanner/codesys”.

If the project is opened properly, the opened project is shown in “Device” section located at left in the
following window.

¥ opener_sample_app.proj

File Edit View Project Build Online Debug Tools Window Help Y
BEE &« b @ X (s (R 92 |2t [ |5 | Application Devicer PLCLogic] ~ OF @, w X [[E5=2=-= 3 o M|(7 %

=51 apener_sample_ann
- [J Device (CODESYS Contral Win v3)
=Bl PLC Logic
= O Application
> .ﬂ Library Manager
[E] pLc_PRE (FRE)
E Task Configuration
= g8 ENIPScannerOTask (IEC Tasks

7 Fiter = | ¥3 Sortby -
%ls«torder -

Property Value

@ EtherMet_IP_Scanner IOCy|
&- & ENIPScannerServiceTask (IEC-T|
" {H] EtherlNet_IP_Scanner Servi
1= g% MainTask (IEC-Tasks)

i pLC_PRG
-] Ethernet (Ethernet)

< >
POUs |5 Devices
Messages - Total 0 error(s), 0 warning(s), 0 message(s) * 0 X
- ‘|0 Derror(s) [ 0warning(s) |G 0 message(s) “ w o
Description Project Object Position
Description
@ Properties | W Motifications
Last build €2 0 & 0 Precompile Project user: (nobody) Q.

Figure 6-2 Open a CODESYS Project
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6.3.2 Network Configuration

Please double-click “Device (CODESYS Control Win V3)” to open “Communication Settings” at center
section, and please click “Scan Network...” to open “Select Device” window.

File Edit View Project Build Online Debug Tools Window Help L 4

= d & LR O {23+ (5" | ¥4 | Application [Device: PLC Logic] ~ &8 LS o || =
Devices ' - 1 X || Device x l 1 = || Properties - I X
= - - o
J,] %"”E’_samofe_aw | Communication Settings ScanNetwork...  Gateway - Device - :Hm "
Device (CODESYS Control Win ¥3) # Sort order
=0 PLC Logic )
) . Applications Property Value
=} Application S
i) Lbrary Manager Backup and Restore
PLC_PRG (PRG)
=-{E8 Task Configuration Files 2 4
=g ENIPScanner]OTask (IEC Tasks) e Gateway L { ]
@) EtherNet_P_Scanner.10Cyde Log
=2 ENIPScannerServiceTask (TEC-Tasks) Gateway-1 ~ -
@] EtherNet_IP_Scanner.ServiceCyde PLC Settings 1P-Address: Press ENTER to set active path...
=& MainTask (EC-Tasks) localhost
) pic_pre PLC Shell Port
# [l Ethernet (Ethernet) 1217
Users and Groups
Access Rights
Symbol Rights
IEC Objects
Task Deployment
Status
Information
Your device can be secursd, Learn mars..
< >
[ POUs | 32 Devices < >
Messages - Total 0 error(s), 0 waming(s), 0 message(s) T
- [ oenorts) [& 0 waming(s) [@ 0 messagels) | % 3
Description Project Object Pasition
Description
Properties [W Notifications
Lastbuild €3 0 @0 Precompile 2 & Project user: (nobody) (%]

Figure 6-3 Communication Settings
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If the software PLC is found after scanning network, the device name (here, PC name) is shown under
Gateway tree. Please double-click this device name (in blue portion).

Select the network path to the controller:

= .13.'1. Gateway-1

Device Name: - Scan Metwork

@ |

[0000.BF53] |

Wink

Device Address:
0000.BF53

Block driver:
LDP

Encrypted
Communication:
TLS supported

Number of
channels:
4

Serial number:

W

conce

Figure 6-4 Select Device

If the network is configured properly, its configuration is shown in “Communication Settings” tab, and there
are the green marks at gateway and device portions.

[l Device x
Communication Settings
Applications

Backup and Restare
Files

Log

PLC Settings

PLC Shell

Users and Groups
Access Rights
Symbol Rights

IEC Objects

Task Deployment

Chatie

Scan Metwork...  Gateway »  Device

Gateway

“ | 0000.BF53) (active) v

IP-Address: Device Name:
localhost

Port Device Address:
1217 0000.BF53

Target ID:
0000 o001

Target Type:
4096

TargetVendor:
35 - Smart Software Solutions GmbH

TargetVersion:
3.5.15.10

Figure 6-5 Green Marks at Gateway and Device Portions
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6.3.3 Interface and IP address configuration
Please click “Ethernet (Ethernet)” in left section to open “Ethernet” tab in center section.

After that, please select “...” button to select network interface ethernet which is connected withRZ/N2L

Industtrial Network SOM Kit, and please configure the IP address and related address values of the ethernet
network interface.

9 opener_sample_app.project” - CODESYS

File Edit \View Project Build Online Debug Tools Window Help A ¢
B &l & X A " | # | Application [Device: PLC Logic] ~ @f LS > |BE|=
Devices v B X [ Device [f] Ethernet x ~ | | Properties * 3 X
=[] apener_sampfe_anp ~ . ‘ " T Filter ~ | ¥ Sortby =
= - " enera
[l Device (CODESYS Control Win V3) Interface | —Hpoh | %lsmt =<
=81 pLC Logic
= £} Application k=g TP address 192 . 168 . 1 . 150 Property Value
m Library Manager Status Subnet mask 255 . 255 . 255 . O
PLCPRG (PRG). Default gateway 192 .168 . 1 . 1 '
= Task Configuration Ethernet Device I/0 Mapping
= 58 ENIPScannerOTask (IEC-Taske) [ Adjust operating system settings
48] Etherhet_IP_Scanner.10Cyde Ethernet Device IEC Objects
=g ENIPScannerServiceTask (IEC Tasks)
4] EtherNet_IP_Scanner.ServiceCyde Information
= inTask (IEC-Tasks)
PLC_PRG
= ([ [Ethernet Ethernet) |
=-[1J EtherNet_IP_Scanner (EtherNet/tP Scanner)
ﬂi Renesas_OpENer_Device (Renesas OpENer Device)
[ POUs |52 Devices < >
Messages - Total 0 error(s), 0 warning(s), 0 message(s) > o x
- [@ aerorts) [@ owaming(s) [@ 0message(s) | X ¥
Description Project Object Position
Description
Properties | W Notifications
Lastbuild @ 0 & 0 Precompile Sé Project user: {nobody) %]

Figure 6-6 Open Ethernet tab
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Next, please double-click “Renesas_OpENer_Device (Renesas OpENer Device)” in the left section to open
“‘Renesas_OpENer_Device” tab in center section.

Finally, please set IP address form to the RZ/N2L Industrial Network SOM Kit device IP address.

9 opener_sample_app.pro

File  Edit View

PLC_PRG (PRG)
= Task Configuration

=-$8 ENIPScannerlOTask (IEC-Tasks)
8] EtherNet_IP_Scanner.I0Cydle

=% ENIPScannerServiceTask (IEC Tasks)
@ EtherNet_IP_Scanner.ServiceCyde

= @ MainTask (IEC-Tasks)
) FLC_FRG

=[] Ethernet (Ethernet)

=-[1J EtherNet_IP_Scanner (EtherNet/tP Scanner) ‘

| [Renesas_OpENer_Device (Renesas OpENer Device)

[ POUs |52 Devices

User-Defined Parameters
Log

EtherNet/IP /0 Mapping
EtherNet/IP IEC Objects
Status

Information

Electronic Keying
Keying Options
(O Compatibility check
(@ Strict identity check
Check device type
Check vendor ID
Check product code

Check major revision

[ Check minar revision

Restore Default Values

Last build: €3 0 & 0

Precompile s gé

Project  Build Online Debug Tools Window Help
B &G o o FAF R LN (3" | #¥ | Application [Device: PLC Logic] - ©F xK v M|
Devices » 8 X | | Devie | ] Ethemet 7| Renesas OpEMer_Device X d || properties v 1
=[] apener_sample_app - I T Filter | ¥ Sortby =
= [ Deviee (CODESYS Control Win V3) Genera Address Settings | sort order =
= @l pcioge Connections IPaddress 192 . 168 . 1 . 170 Property Value
= i} application : : : Etherl ‘etl per
il Library Manager [

>
Messages - Total 0 error(s), 0 warning(s), 0 message(s) © 4 &
- [@ oerorts) [@ owaming(s) [@ 0message(s) | X ¥
Description Project Object Position
Description
Properties | W Notifications

Praject user: (nabody) %)

Figure 6-7 Renesas_OpENer_Device (Renesas OpENer Device)
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6.4 Operation Check

6.4.1 Build Project and Start Application
Follow the following steps and figure to build the project and start the application.

1. Click “Build” button in the tool bar to build the CODESY'S project.
2. Click “Login” button in the tool bar to login the network.
3. Click “Start” button in the tool bar to run network and application.

>

[ R L oEE _‘T B Application [Device: PLC Logic] = -'-aﬁ

-

# 05 d G {9+ [ #¥ | Application [Device: PLC Logic] ~ @ e

| 4

# 5L 4% 0G £+ (7 #4 | Application [Device: PLC Logic] -~ % &[]

&

o

)

El

Figure 6-8 Build Project and Start Application

6.4.2 Check Network Connection

If the CODESYS application on PC connects with OpENer application on RZ/N2L properly, “Device”,
“Ethernet”, “EtherNet_IP_Scanner”, and “Renesas_OpENer_Device” in left section are marked with green

cycle mark.

= apener_samole_apo

= ﬁ Device [connected] (CODESYS Contral Win V.3)
=Bl PLE Logic
= "',. Application [run]
m Library Manager
PLC_PRG (FRG)
= @ Task Configuration
= @ EMIPScanner]OTask (IEC-Tasks)
Iﬁ_?l EtherMet_IP_Scanner.I0Cyde
= @ EMIPScannerServiceTask (IEC-Tasks)
@ EtherMet_IP_Scanner.ServiceCyde
= @ MainTask (IEC-Tasks)
] PLC_PRG
= ﬂj Ethernet (Ethernet)
= m EtherMet_IP_Scanner (EtherMNet/IP Scanner)
ﬂj Renesas_OpEMer_Device (Renesas OpEMer Device)

Figure 6-9 Check Network Connection
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6.4.3 Check Application Behavior
Please open “EtherNet/IP I/O Mapping” page in “Renesas_OpENer_Device” tab.

This page shows the Exclusive Owner Connection and Input Only Connection mapping which indicates the
connections between the CODESYS PLC application and the Assembly objects on RZ/N2L OpENer
application. The “Current Value” column indicates the LED and SW3 values.

»  The Exclusive Owner Connection is bound to LED of RZ/N2L Industrial Network SOM Kit.
- The LEDs lights by shifting with [SW Value] Hz.

»  The Input Only Connection is bound to J6-1 ~ J6-4 of RZ/N2L Industrial Network SOM Kit.
- The SW values indicates the frequency of LED light shifting.

[f] Device [f]_Ethernet [] Renesas_OpENer_Device X hd
General Find Filter Show all » =k Add FB for IO Channel... Go to Instance J
. Variable Mapping  Channel Address Type Current Value F
Comnections E [l Board LED Exdusive Owner )
Assemblies = *§ Application.PLC_PRG.Board_LED_Input T Board LED Input Data 24IRG BYTE 2
3 Bit0 SLTEGD BOOL
User-Defined Parameters R Bit1 Eeliat BOOL
E Bit2 %Ixe.2 BOOL
g L] Bit3 P BOOL
R Bit4 L BOOL
EtherNet/IP If0 Mapping 1 4y Bits HIe.S BOOL
EtherNet/IP IEC Objects “ Bite RS BOCL
k. Bit7 INGTF BOOL
Status =" Application,PLC_PRG.Board_LED_Output ] Board LED Qutput Data LB BYTE
" BitD prr=mny BOOL
Information " Bit1 %ower  BOOL
"9 Bit2 PRy BOOL
"% Bit3 %o¥%a3 BOOL
"% Bit4 %o%a4 BOOL
] Bit5 OHES BOOL
" Bitts pre=m s BOOL
" Bit7 HOHEF BOOL
=~ [l Board SW Input Only
=\ *$ Application.PLC_PRG.Board_SW_Input ] Board SE Input Data IR BYTE
R BitD STHR BOOL
R/ Bit1 Wb BOOL
3 Bit2 HBie BOOL
* Bit3 EEaE) BOOL
k. Bit4 B BOOL
k. BitS HINLE BOOL
3 Bits TR BOOL
% Bit7 P BOOL
< >
| Reszet Mapping Always updatevariables |Use parent device setting
@ = Createnew variable " =Mapto existing variable
Figure 6-10 Check Application Behavior
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7. Appendix

Appendix A: OSS implemented in the sample code
The following three OSS are used in the sample code.

OpENer

The "OpENer" is an open-source software for I/O communication adapters of EtherNet/IP. Please refer the
following link for the detail.

httos://qithub.com/EIPStackGroup/OpENer

»  Git comment ID used in this sample software: 05cdd03

This package is the RZ/N2L port of OpENer and includes OpENer source codes. Regarding the open-source
license of OpENer, please see the following file.

common\oss\OpENer\license.txt

FreeRTOS

The FreeRTOS is an open-source software for real-time operating system (RTOS) for microcontrollers.
Please refer the following link for the details.

https://aws.amazon.com/freertos/

https://qithub.com/aws/amazon-freertos

»  Git comment ID used in this sample software: a038063

The RZ/N2L port of OpENer includes FreeRTOS source codes as a RTOS kernel. Regarding the open-
source license of OpENer, please see the following file.

common\oss\amazon-freertos\LICENSE

lwiP

The IwlP is an open-source software for a small independent implementation of the TCP/IP protocol suite.
Please refer the following link for the details.

httos://savannah.nongnu.org/projects/Iwip/

httos://qithub.com/Iwip-tcpip/Iwip

»  Git comment ID used in this sample software: 79cd89f

The RZ/N2L port of OpENer includes IwlP source codes as a TCP/IP stack. Regarding the open-source
license of IwIP, please see the following file.

common\oss\1wip\COPYING
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Appendix B: Assembly Objects and I/0 Connections

This sample application has the 7 instances of Assembly object. 5 of these instances are bound to the
following array variables.

Table 7-1 Assembly Objects and I/O Connections

Instance No. Type Description Bound variables

100 (Ox64) Static Input Input of Exclusive Owner g assembly data led input[1]
I/0O Connection bound to
LED

101 (0x65) Static Input Input of Input Only 1/0O g assembly data sw_input[1]
Connection bound to
SW3

150 (0x96) Static Output Input of Exclusive Owner g assembly data led output[1]
I/O Connection bound to
LED

151 (0x97) Static Configuration of 1/0 g assembly data config[4]

Configuration Connections

154 (0x9A) Static 1/0 Accessing by explicit g assembly data explicit[4]
message connection only

238 (OxEE) Static Output Heartbeat output of Input -
only 1/0 Connection
bound to SW3

237 (OxED) Static Output Heartbeat output of listen -
only 1/0 Connection.
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Appendix C: Support CIP Object Classes
The CIP object classes on OpENer RZ/N2L port are shown below.

Table 7-2 CIP Object Class on OpENer RZ/N2L port

Object Class # Object Class Name
0x01 Identity

0x02 Massage Router
0x04 Assembly

0x06 Connection Manager
OxF5 TCP/IP Interface
OxF6 Ethernet Link

0x48 QoS

Table 7-3 0x01: Identity
Class Attributes

Attribute Name Get Set
Revision @) -
Max Instance O -
Number of Instance O -

Optional Attribute List

Optional Service List

Max Number Class Attributes
Max Number Instance Attributes
Class Services

# Service Name

0x01 | Get_Attributes_All

OxOE | Get_Attribute_Single
Instance Attributes*

N[OOI WIN| =

oo

# Attribute Name Get Set
1 Vendor ID O -
2 Device Type O -
3 Product Code O -
4 Revision O -
5 Status O -
6 Serial Number O -
7 Product Name O -
Instance Service

# Service Name

0x01 | Get_Attributes_All

0x05 | Reset

OxOE | Get_Attribute_Single

*: The values of instance attributes #1~#4, #6, and #7 are configured by macros in “deveicedata.h" in
“‘common\renesas\oss_deps\opener” directory.
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Table 7-4 0x02: Massage Router
Class Attributes

Attribute Name Get Set
Revision O -
Max Instance O -
Number of Instance O -

Optional Attribute List - -

Optional Service List -

Max Number Class Attributes O -
O

N OO WIN|=

Max Number Instance Attributes
Class Services

# Service Name

0x01 | Get_Attributes_All

OxOE | Get_Attribute_Single

Instance Attributes*

# | Attribute Name | Get | Set
No instance attributes are implemented.

Instance Service

# Service Name

OxOE | Get_Attribute_Single

Table 7-5 0x04: Assembly
Class Attributes

# Attribute Name Get Set
1 Revision O -

2 Max Instance O -

3 Number of Instance O -

4 Optional Attribute List - -

5 Optional Service List - -

6 Max Number Class Attributes O -

7 Max Number Instance Attributes O -
Class Services

# Service Name

OxOE | Get_Attribute_Single
Instance Attributes*

# Attribute Name Get Set
3 Data O O
4 Size O -
Instance Service

# Service Name

OxOE | Get_Attribute_Single
0x10 | Set_ Attribute_Single
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Table 7-6 0x06: Connection Manager

Class Attributes

Attribute Name Get Set
Revision O -
Max Instance O -
Number of Instance O -

Optional Attribute List - -
Optional Service List

Max Number Class Attributes
Max Number Instance Attributes
Class Services

# Service Name

0x01 | Get_Attributes_All

OxOE | Get_Attribute_Single

Instance Attributes*

# | Attribute Name | Get | Set
No instance attributes are implemented.

Instance Service

# Service Name

OxOE | Get_Attribute_Single

Ox4E | Forward_Close

0x54 | Forward _Open

0x5a | Get_Connection_Owner

0x5b | Large Forward Open

N[O O WIN| = |H

oo}
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Table 7-7 0xF5: TCP/IP Interface

Class Attributes
# Attribute Name Get Set
1 Revision O -
2 Max Instance O -
3 Number of Instance O -
4 Optional Attribute List - -
5 Optional Service List - -
6 Max Number Class Attributes O -
7 Max Number Instance Attributes O -
Class Services
# Service Name
0x01 | Get_Attributes_All
OxOE | Get_Attribute_Single
Instance Attributes*
# Attribute Name Get Set
1 Status O -
2 Configuration Capacity O -
3 Configuration Control O O
4 Physical Link Object O -
5 Interface Configuration O -
6 Host name O -
8 TTL Value O -
9 Mcast Config O -
13 Encapsulation Inactivity Timeout O O
Instance Service
# Service Name
0x01 | Get_Attributes_All
OxOE | Get_Attribute_Single
0x10 | Set_ Attribute_Single
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Table 7-8 0xF6: Ethernet Link

Class Attributes
# Attribute Name Get Set
1 Revision O -
2 Max Instance O -
3 Number of Instance O -
4 Optional Attribute List - -
5 Optional Service List - -
6 Max Number Class Attributes O -
7 Max Number Instance Attributes O -
Class Services
# Service Name
0x01 | Get_Attributes_All
OxOE | Get_Attribute_Single
Instance Attributes*
# Attribute Name Get Set
1 Interface Speed O -
2 Interface Flag O -
3 Physical Address O -
7 Interface Type O -
11 Interface Capability O -
Instance Service
# Service Name
0x01 | Get_Attributes_All
OxOE | Get_Attribute_Single
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Table 7-9 0x48: QoS

Class Attributes
# Attribute Name Get Set
1 Revision O -
2 Max Instance O -
3 Number of Instance O -
4 Optional Attribute List - -
5 Optional Service List - -
6 Max Number Class Attributes O -
7 Max Number Instance Attributes O -
Class Services
# Service Name
0x01 | Get_Attributes_All
OxOE | Get_Attribute_Single
Instance Attributes*
# Attribute Name Get Set
1 802.1Q Tag Enable O -
2 DSCP PTP Event O -
3 DSCP PTP General O -
4 DSCP Urgent O O
5 DSCP Scheduled O O
6 DSCP High O O
7 DSCP Low O O
8 DSCP Explicit O O
Instance Service
# Service Name
0x01 | Get_Attributes_All
OxOE | Get_Attribute_Single
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Appendix D: FSP Configuration for VSC8531

RZ/N2L Industrial Network SOM Kit has VSC8531 as PHY chip.
If reconfiguring by latest FSP, FSP configuration and source code needs to change from default.

(1) Regenerate source files by lates FSP
Remove the following four folders. After that, open the project according to section 5.
- When using e2studio, \project\rzn2l_som\opener_single\e2studio

- When using EWARM, \project\rzn2|_som\opener_single\ewarm

rzn

rzn_cfg
rZn_gen « Remove these folders

sCript
&re

Figure 7-1 Remove folder generated by FSP

(2) Change ethernet driver configuration for VSC8531

Configure g_ether_phy0 Ethernet Driver on r_ether_phy for VSC8531 as shown in Figure 7-2.
Configuration value for VSC8531 shows in Table 7-10.

o *[RZN2L_STAMP_OpENer single] FSP Configuration > =8 |8 Properties
Stacks Configuration G g_ether_phy0 Ethernet Driver on r_ether_phy
Generate Project Content
4““@; Property Value
gy B (o T g_ether0 Ethernet Driver on ] New Stack > v Common
% | Remove [ r_ether Stacks % | Remove Select PHYs to use
T RAL/C Parameter Checking Default (BSP)
v /Common R
£ g ioport /0 Port Driver on Py g_ctherd Ethemet Driver on r_ether w Medule g_ether_phyl Ethernet Driver on r_e
va Ma\gr:T:rEad MName g:ethar,phyD
Channel G0
4+ g_etherl Ethernet Driver on ® PHY-LS| Addrees 1‘
& o_uart0 UART Driver on _sc ry PHY-LS| Reset Completion Timeout  (x00020000
47 Heap 4 e e I I Flow Control & Disable
i
4% g_iZc_masterd 12C Master D 25 g_FilmrJ)hyﬂ Ethernet %7 Add Ethernet PHY 5 Add Etherne Port Tepe ‘E_t‘hemet
Driver on r_ether_phy Driver chl Driver ch2
| Select PHY VSCa541 |
(1) Select MDIO type GMAC
= Y a Auto Megotiation onN
Speed 10/100/1000M
& g_ether_selectord Duplex FULL
Objects & New Object > Ethernet Driver on Recet Port 12
r_ether_selector
® Reset Pin 4
Reset assert time 15000
< b3
Surnmary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Cormponents

Figure 7-2 Ethernet Driver Configuration for VSC8531 (e.g. ETHO)

Table 7-10 FSP Configuration Value for VSC8531

Items Default value Config value for VSC8531
ETHO ETH1
PHY-LSI Address 0 0 1
Select PHY Default VSC8541 VSC8541
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(3) Add initialization code for VSC8531

The following code for VSC8531 initialization should be added to “ether_phy targets_initialize vsc8541
function in rzn/fsp/src/r_ether_phy/r_ether_phy.c.

The inclusion of “board_som.h” is aiso required for code activation.

[#include "board_som.h"

~~ Omission ~~

void ether_phy_targets_initialize_vsc8541 (ether_phy_instance_ctrl_t * p_instance_ctrl)

{

~~ Omission ~~

/* LED Behavior */
reg = ether_phy read(p_instance_ctrl, ETHER_PHY_REG_LED BEHAVIOR);
reg &= ~(1U << ETHER_PHY_REG_LED®_FEATURE_DISABLE_OFFSET);
reg |= 1U << ETHER_PHY_REG_LED1_FEATURE_DISABLE_OFFSET;
ether_phy_write(p_instance_ctrl, ETHER_PHY_REG_LED_BEHAVIOR, reg);
#if defined(BOARD_RZN2L_SOM_KIT) /* for VSC8531 */
/* select extended page 2 register */
ether_phy _write(p_instance_ctrl, ETHER_PHY_REG_EXTEND_GPIO_PAGE, 0x02);

/* read WoL and MAC Interface Control */
reg = ether_phy_read(p_instance_ctrl, 0x1b);

/* set control to slow */
reg &= OXFF9F;
ether_phy _write(p_instance_ctrl, 0x1lb, reg);

/* Configure RX_CLK delay and TX_CLK delay to 2.@ns */
ether_phy write(p_instance_ctrl, ETHER_PHY_REG_EXPAGE2_RGMII_CTRL, 0x0044);

/* select extended page 9 register */
ether_phy_write(p_instance_ctrl, ETHER_PHY_REG_EXTEND_GPIO_PAGE, 0x00);

ttendif
} /* End of function ether_phy targets_initialize() */
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Licenses

e OpENer
Regarding the license of OpENer, please see the following file.
common\oss\OpENer\license.txt

e FreeRTOS

Regarding the license of FreeRTOS, please see the following file.
common\oss\amazon-freertos\LICENSE

o IWlIP
Regarding the license of IwIP, please see the following file.
common\oss\1wip\COPYING
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vin (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between ViL (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.

+ Arm® and Cortex® are registered trademarks of Arm Limited (or its subsidiaries) in the EU and/or elsewhere.
All rights reserved.

- Ethernet is a registered trademark of Fuji Xerox Co. Ltd.

- |IEEE is a registered trademark of the Institute of Electrical and Electronics Engineers Inc

+ Additionally all product names and service names in this document are a trademark or a registered trademark

which belongs to the respective owners. a trademark or a registered trademark which belongs to the respective
owners.
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(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2022 Renesas Electronics Corporation. All rights reserved.
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